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Introduction

You can use Multidimensional Analysis to record detailed data about your
transactions and perform detailed analysis of that data after you've posted, without
creating a highly detailed chart of accounts. This is possible because you can assign
an unlimited number of analysis groups and codes to individual transaction
distributions.

You also can use Multidimensional Analysis to complete the following tasks:

Set up an unlimited number of analysis codes and groups
Combine analysis codes into groups

Automatically apply information to transaction distributions
Perform comprehensive inquiry and reporting

This introduction is divided into the following sections:

What's in this manual

Symbols and conventions

Resources available from the Help menu
Send us your documentation comments

What's in this manual

This manual is designed to give you an in-depth understanding of how to use the
features of Multidimensional Analysis, and how it integrates with the Microsoft
Dynamics® GP system.

To make best use of Multidimensional Analysis, you should be familiar with
systemwide features described in the System User’s Guide, the System Setup
Guide, and the System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you're using
and which modules or features you are registered to use, choose Help >> About
Microsoft Dynamics GP.

The manual is divided into the following parts:
e Part1, Setup and transactions, walks you through setting up analysis codes

and groups, and assigning them to accounts. It also describes how to enter
analysis information with transactions.

e Part2, Inquiries, reports, and utilities, describes how to perform inquiries by
analysis group or code and how to print reports that provide information about
analysis groups and codes. It also describes reconciling, the process of verifying
that your Multidimensional Analysis records are accurate.

MULTIDIMENSIONAL ANALYSIS



INTRODUCTION

Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the

glossary in Help.
Symbol Description
NV The light bulb symbol indicates helpful tips, shortcuts and

suggestions.

The warning symbol indicates situations you should be especially
aware of when completing tasks.

This manual uses the following conventions to refer to sections, navigation and

other information.

Convention

Description

Creating a batch

Italicized type indicates the name of a section or procedure.

File >> Print or File >
Print

The (>>) or (>) symbol indicates a sequence of actions, such as
selecting items from a menu or toolbar, or pressing buttons in a

window. This example directs you to go to the File menu and choose
Print.

TAB or ENTER All capital letters indicate a key or a key sequence.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance
resources on your computer, as well as on the Web.

Contents

Opens the Help file for the active Microsoft Dynamics GP component, and displays
the main “contents” topic. To browse a more detailed table of contents, click the
Contents tab above the Help navigation pane. Items in the contents topic and tab
are arranged by module. If the contents for the active component includes an
“Additional Help files” topic, click the links to view separate Help files that
describe additional components.

To find information in Help by using the index or full-text search, click the
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab.
Click Add.

Index

Opens the Help file for the active Microsoft Dynamics GP component, with the
Index tab active. To find information about a window that’s not currently displayed,
type the name of the window, and click Display.

About this window

Displays overview information about the current window. To view related topics
and descriptions of the fields, buttons, and menus for the window, choose the
appropriate link in the topic. You also can press F1 to display Help about the current
window.
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Lookup

Opens a lookup window, if a window that you are viewing has a lookup window.
For example, if the Checkbook Maintenance window is open, you can choose this
item to open the Checkbooks lookup window.

Show Required Fields

Highlights fields that are required to have entries. Required fields must contain
information before you can save the record and close the window. On the Microsoft
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals

Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or
view.

What's New

Provides information about enhancements that were added to Microsoft Dynamics
GP since the last major release.

Microsoft Dynamics GP Online

Opens a Web page that provides links to a variety of Web-based user assistance
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent
revisions of upgrade and implementation documentation, plus documentation
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics
GP product support plans and options that are available, along with
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support,
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you
can ask questions or share your expertise with other Microsoft Dynamics GP
users.

CustomerSource home page A wide range of resources available to
customers who are registered for a paid support plan. Includes access to
Knowledge Base articles, software downloads, self-support, and much more.

Customer Feedback Options

Provides information about how you can join the Customer Experience
Improvement Program to improve the quality, reliability, and performance of
Microsoft® software and services.
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Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP
documentation. If you have specific suggestions or find any errors in this manual,
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use
them freely.
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Part 1: Setup and transactions

Use this part of the documentation to set up analysis codes and groups, assign
analysis groups to accounts, and enter analysis information with transactions. This

information is divided into the following sections:

¢ Chapter 1, “Setup,” contains information about setting up Multidimensional
Analysis.

e Chapter 2, “Transactions,” explains how to enter analysis information with
transactions in General Ledger, Receivables Management, Invoicing, Sales
Order Processing, Payables Management, and Purchase Order Processing.
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Chapter 1: Setup

To use Multidimensional Analysis, you need to set up analysis codes and groups,
and assign them to accounts. You generally complete setup procedures once, but
you might want to refer to this material again for viewing the setup selections
you’ve made, or to add, delete, or modify your analysis codes and groups.

When you’ve completed the steps described in this document, you'll be ready to
begin performing the tasks described in Chapter 2, “Transactions.”

This information is divided into the following sections:

*  Before you set up Multidimensional Analysis
*  Multidimensional Analysis overview

*  Setting up analysis groups and codes

¢ Deleting analysis groups and codes

*  Assigning analysis groups to accounts

Before you set up Multidimensional Analysis

Before you begin setting up Multidimensional Analysis, be sure you've completed

the setup procedures for System Manager and General Ledger, as well as for the
modules with which you’ll be using Multidimensional Analysis. You can use
Multidimensional Analysis with transactions in General Ledger, Receivables
Management, Invoicing, Sales Order Processing, Payables Management, and
Purchase Order Processing.

For more information about completing setup procedures for a particular module,
refer to the module’s documentation.

MULTIDIMENSIONAL ANALYSIS

9



PART 1 SETUP AND TRANSACTIONS

10

Multidimensional Analysis overview

The following flowchart describes the sequence of activities involved in setting up
and using Multidimensional Analysis.

System Setup
Set up System Manager.
Set up General Ledger.

/
Module Setup
Create analysis groups and codes.
Set up account analysis codes.

y

Transaction Entry
Assign analysis amounts to
transactions in General Ledger,
Invoicing, Payables Management,
Purchase Order Processing,
Receivables Management and
Sales Order Processing.

Y A
Inquiries Reports
View transactions that have Print reports to show detailed
analysis groups and codes analysis group and code
assigned to them. information for posted and
unposted transactions.

Setting up analysis groups and codes

When you set up Multidimensional Analysis, you'll define analysis codes and
analysis groups.

Analysis codes Identifiers in Microsoft Dynamics GP for items to analyze. For
example, you could create analysis codes for each of your company vehicles.

Analysis groups Identifiers in Microsoft Dynamics GP for a group of analysis
codes. For example, you could create an analysis group for your vehicle fleet.

Use the Analysis Group Maintenance window to create the group or groups to

perform detailed analysis for. For each analysis group you create, you can then
define the items to analyze.
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CHAPTER 1 SETUP

To set up analysis groups and codes:

1.

Open the Analysis Group Maintenance window.
(Cards >> Financial >> Analysis Groups)

I Analysis Group Maintenance g@@
I Save | X Delste S
Analysis Group D VEHICLES R0
Description Wehicle Flest
Analysic Code 1D Description
ABC123 Service Van 1 »~
EFG723 Service VYan 2
v
TR {r @

Enter an analysis group and description. For example, you could create an
analysis group for the expenses related to your company’s fleet of service
vehicles.

Enter analysis codes and descriptions. For example, if you were creating a
group for your service vehicles, you could add analysis codes for each
individual vehicle, using the license number as the analysis code.

Choose Save to save the group and its codes. The window will remain open, so
you can continue entering analysis groups.

Verify your entries by printing the Analysis Group Setup List. You can print this
report while the Analysis Group Maintenance window is open by choosing File
>> Print.

You also can print this report using the Multidimensional Analysis Reports
window. For more information, see Specifying a Multidimensional Analysis report

option on page 26.

Deleting analysis groups and codes

You can delete an analysis group or code only if the following conditions apply:

The code or group has not been assigned to an account.

The code or group has not been assigned to a transaction that has
Multidimensional Analysis information entered in an analysis posting detail
window.

To delete analysis groups and codes:

1.

Open the Analysis Group Maintenance window.
(Cards >> Financial >> Analysis Groups)

Enter or select an existing analysis group.

To delete an analysis code from the group, highlight the code and choose Edit
>> Delete Row.

To delete an analysis group, choose the Delete button.

MULTIDIMENSIONAL ANALYSIS 1"
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Assigning analysis groups to accounts

Use the Account Analysis Defaults window to assign analysis groups to accounts
you want to track detailed analysis information for. For example, if you created an
analysis group for your service vehicle expenses, you would assign that group to
each of the accounts that record your vehicle expenses. You can assign multiple
analysis groups to an account.

~~- Analysis groups can be assigned only to posting accounts.

For each analysis group assigned to an account, you'll indicate an analysis type—
whether or not analysis amounts should be recorded every time a transaction is
posted to that account. You also can enter percentages to determine the amounts
recorded during transaction entry.

Receivables Management, debit memos using either the receivables or overpayment writeoff
account will not post if the Multidimensional Analysis groups for the account don’t equal
one hundred percent.

N @/ All Multidimensional Analysis group types can be used with writeoff accounts. In

The following table lists the analysis types you can choose for an analysis group.

Analysis type Allowed changes

Optional Codes can be added or deleted. If any codes and amounts are entered,
the total must equal the posting amount before you post.

Required Codes must be entered. The default amounts for the codes can be
changed or removed, as long as the total amount equals the posting
amount before you post.

Fixed Codes must be recorded and the total amount must equal the posting
amount before you can save or post. The default amounts recorded
for the codes cannot be changed or removed.

None No analysis codes or amounts can be entered when entering
Multidimensional information about a transaction. You can use this
analysis type when you want to prohibit analysis for an analysis
group, but you don’t want to delete the group.

To assign analysis groups to accounts:

1. Open the Account Analysis Defaults window.
(Cards >> Financial >> Analysis Defaults)

il Account Analysis Defaults |Z”E|gl

B Save | ¥ Delate |

Account 1000 -1000-0000 -1555 -0000 =
Descripion | ACCUM, DEPR.TRUCKS

Analysis Group 1D ‘Qluuanl\t\es |De:|ma\ Places ‘ Analysis Type

Group Description
EHICLES F 0 Required
O

| \ >

<«

>

<<

Current Group WVEHICLES

[Analysis Coda ID
| Code Desciption
EFG123 Depreciation - Service van 2 50.00% A
ABC7ES Depreciation - Service van 1 50.00%
I 0.00%

22Posting Description Percent

[«[»]

v

Total 100,002

44 @
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Enter or select an account.

Enter or select an analysis group to apply to this account.

Indicate whether to allow quantities to be entered during transaction entry in
addition to currency amounts. You can specify quantities to be entered for each
analysis group you’ve assigned to the account.

For example, if you have an analysis group to track printing expenses, you
could use this field to track the number of cases of paper purchased. The

quantity information is for reporting purposes only and doesn’t affect posting.

If you’'ve marked Quantities, select the number of decimal places that will be
used to display quantities.

Select an analysis type. That is, specify whether entering amounts against the
analysis codes in this group during transaction entry is optional or required,

and if it’s required, whether or not the amounts can be changed.

Enter or select the analysis codes in the selected group that should be applied to
this account.

Enter a posting description and a default percentage amount for each code.
Choose Save.

When transactions involving the account are posted, the distribution amount
will be allocated across all of the default codes by the appropriate percentages.
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Chapter 2:

Transactions

You can enter analysis information when you enter transactions in General Ledger,
Receivables Management, Invoicing, Sales Order Processing, Payables
Management, and Purchase Order Processing.

Posting reports will be printed when you post transactions, either individually or in
batches. For more information about posting reports for Multidimensional
Analysis, refer to Chapter 4, “Reports.”

For more information about setting up posting, see the System Setup Guide (Help
>> Printable Manuals>> select System >> select System Setup Guide).

This information is divided into the following sections:

Effects of Multidimensional Analysis on other modules
Entering analysis information during transaction entry
Viewing and modifying multidimensional analysis amounts
Analysis information in transactions posted to General Ledger
Viewing analysis information by posting amount

Viewing analysis information by document number

Effects of Multidimensional Analysis on other
modules

When you're using Multidimensional Analysis, you should be aware of the
following effects:

Deleting a batch of transactions or an individual transaction also deletes the
analysis information entered on the transaction.

Voiding a transaction that has been posted to General Ledger removes the
analysis information from the transaction.

Posting a transaction with an optional analysis group whose codes don’t have
any amounts deletes the analysis information.

You also should be aware of how Multidimensional Analysis works with other
modules. Refer to the table for more information.

Module Document types | Notes

Receivables Management You can use

Multidimensional
Analysis with all
document types.

Payables Management You can use

Multidimensional
Analysis only with
transactions entered
on the transaction
entry windows. You
can’t use
Multidimensional
Analysis when
creating payments in
Payables
Management.
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Document types

Notes

You can use
Multidimensional
Analysis with journal
entries.

Removing transaction history also
removes Multidimensional Analysis
information.

Closing a year updates posting status
from Open to History, and, if you are
keeping history, moves Multidimensional
Analysis information to history. If you are
not keeping history, closing a year
removes Multidimensional Analysis along
with the associated Open records in the
year being closed.

Posting a reversing transaction (for which
debit and credit entries will be reversed at
a later date) also reverses the analysis
information assigned to the transaction.

You can use
Multidimensional
Analysis with all
document types.

Analysis information for the Inventory and
Cost of Goods Sold accounts is created as
part of the posting process. (You can edit
the analysis information for these
accounts after the information is posted to
General Ledger.)

You can use
Multidimensional
Analysis with
shipments,
shipment/invoices,
and invoices.

Automatically receiving or invoicing items
for a receipt that already has received or
invoiced items updates the existing
analysis information for the items.

You can use
Multidimensional
Analysis with
invoices and returns.

Transferring a quote to an invoice or an
order to an invoice creates analysis
information.

Analysis information for the Inventory and
Cost of Goods Sold accounts is created as
part of the posting process. (You can edit
the analysis information for these
accounts after the information is posted to
General Ledger.)

PART 1 SETUP AND TRANSACTIONS
Module
General Ledger
Invoicing
Purchase Order Processing
Sales Order Processing
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CHAPTER 2 TRANSACTIONS

Entering analysis information during transaction entry

If a transaction includes distributions to an account that you have assigned analysis
groups to, Multidimensional Analysis automatically will record amounts against
the analysis codes according to the default percentages you entered in the Account
Analysis Defaults window.

If you need to view and modify these amounts, do so using the following analysis
posting detail windows:

Module

Transaction entry
window

Analysis posting detail
window

General Ledger

Transaction Entry window

Analysis Posting Detail window

Invoicing

Invoice Entry window

Invoice Analysis Posting Detail
window

Payables Management

Payables Transaction Entry
window

Payables Manual Payment
Entry window

Edit Payables Checks
window

Payables Analysis Posting Detail
window

Purchase Order Processing

Receivings Transaction
Entry window
Purchasing Invoice Entry
window

Receivings Analysis Posting Detail
window

Purchasing Invoice Analysis
Posting Detail window

Receivables Management

Receivables Transaction
Entry window

Receivables Analysis Posting
Detail window

Sales Order Processing

Sales Transaction Entry
window

Sales Analysis Posting Detail
window

The procedure for viewing and modifying the amounts recorded against the
analysis codes is the same for all of the analysis posting detail windows. Refer to

Viewing and modifying multidimensional analysis amounts on page 17 for more

information.

For information about the other analysis posting detail windows, refer to online

help.

Viewing and modifying multidimensional analysis
amounts

You’ll use one of several analysis posting detail windows to view and modify the
amounts recorded against the analysis codes assigned to an account, depending on
the transaction entry window used to create the transaction. Refer to Entering
analysis information during transaction entry on page 17 for more information about
which analysis posting window is used with which transaction window.

The basic process is the same for all of these windows, but each window requires
different navigation. The following procedure describes how you can use the
Analysis Posting Detail window to view information about a General Ledger
transaction.
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SETUP AND TRANSACTIONS

To view and modify multidimensional analysis amounts:

1.

Open the Transaction Entry window.
(Transactions >> Financial >> General)

Enter or select a transaction that includes a distribution to an account you have
assigned analysis groups to, and choose to view the distributions.

In General Ledger, account distributions are displayed directly in the
Transaction Entry window. In other transaction entry windows you might need

to choose the Distributions button to open a distributions window.

Highlight an account you've assigned analysis groups to, and choose the
Account Analysis button.

— Account Analysis button

You also can choose View >> Analysis to open the Analysis Posting Detail window.

The Analysis Posting Detail window opens. Any analysis groups assigned to
this account will appear in this window.

Il Analysis Posting Detail g@@
Account 000-1535-00
Description Accumulated Depreciation-Flest Vehicles
Pasting Amouint A $20.00CR
Document Mumber 3
Analysis Group 1D Group Description Analysis Type

WVEHICLES “Wehicle Fleet Required -~

Current Group VEHICLES Autg Allocate

Analysis Code 1D Fasting Deseription Quantiy Amaunt
Code Description
ABC123 Depreciation - Service Yan 1 0 $10.00 A~
EFG7E3 D epreciation - Service Yan 2 0 $10.00
$0.00 $0.00
~
Total $20.00
Lr @ 0K | [ Delets | [ Detaut

Select a group to view the analysis codes and default amounts. Depending on
the analysis type of the group, you might be able to make changes to the codes
and the amounts for each code.

After making changes, you can choose Default to restore the default analysis groups and
amounts. You also can allocate any remaining amount to any codes with an amount of
zero by choosing Auto Allocate. For example, to allocate the entire amount of a
distribution to a single code, you can delete all the other codes (select each code and
choose Edit >> Delete Row), enter a zero amount in the remaining code and then choose
Auto Allocate.

Choose OK to save your changes and close the Analysis Posting Detail window.

18 MULTIDIMENSIONAL ANALYSIS



CHAPTER 2 TRANSACTIONS

Analysis information in transactions posted to
General Ledger

If you're posting in summary to General Ledger, the analysis detail information will
be retained even if the General Ledger account amounts are posted in summary.
You’ll be able to view the detail analysis information by using browse buttons in the
Analysis Posting Detail window and the Analysis Inquiry window.

~y~- Forinformation about creating a single journal entry for the batch total of each account, as
well as other posting setup options, see the System Setup Guide (Help >> Printable
Manuals>> select System >> select System Setup Guide).

The Posting Amount browse buttons are available when the original transaction has
two or more distributions using the same account. The Document Number browse
buttons are available when two or more transactions using the same posting
accounts are saved in a batch.

Viewing analysis information by posting amount

Assume that you set up the Purchase Expense account, 1000-1000-0000-5166-0000,
to track analysis information. In the Payables Management module, assume that
you’'ve entered the following transaction with two distributions using the same
account in a batch.

Account Distribution Type Debit Credit
1000-1000-0000-5166-0000 PURCH $100
1000-1000-0000-5166-0000 MISC $10
1000-1000-0000-2120-0000 PAY $110

When you post the batch to General Ledger in summary, the following journal entry
will be created in General Ledger:

Account Debit Credit
1000-1000-0000-5166-0000 $110
1000-1000-0000-2120-0000 $110

When you view the analysis information for the Purchase Expense account in the
Analysis Posting Detail window or its inquiry window, the Posting Amount browse
buttons will be available. You can use the browse buttons on the Posting Amount
field to view additional distributions for the account.

Account 1000-1000-0000-5116-0000

Dezcription Purchasing Expense

Pozting Amount n $10.00
Document Number 00000000000000387
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Viewing analysis information by document number

Assume that you set up the Purchase Expense account, 1000-1000-0000-5166-0000,
to track analysis information. In the Payables Management module, assume that
you've entered the following two transactions in the same batch.

Transaction Account Debit Credit

PM00052 1000-1000-0000-5166-0000 $100
1000-1000-0000-2120-0000 $100

PM00053 1000-1000-0000-5166-0000 $250
1000-1000-0000-2120-0000 $250

When you post the batch to General Ledger in summary, the following journal entry
will be created in General Ledger:

Account Debit Credit
1000-1000-0000-5166-0000 $350
1000-1000-0000-2120-0000 $350

When you view the analysis information for the Purchase Expense account in the
Analysis Posting Detail window or its inquiry window, the Document Number
browse buttons will be available. You can use those browse buttons to view the
analysis amounts for each document.

Account 1000-1000-0000-5116-0000
Description Purchasing Expenze

Posting Amaunt $250.00 E
Document Murber n 00000000000000389
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Part 2: Inquiries, reports, and
utilities
Use this part of the documentation to perform inquiries by analysis group or code
and print reports that provide information about analysis groups and codes. This
part also contains information about the reconciliation utility used to verify that

your Multidimensional Analysis records are accurate. This information is divided
into the following sections:

e Chapter 3, “Inquiries,” explains how to access detailed and summarized
Multidimensional Analysis information.

e Chapter 4, “Reports,” guides you through using Multidimensional Analysis
reports.

e Chapter 5, “Utilities,” explains the process of reconciling Multidimensional
Analysis records.
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Chapter 3:

Inquiries

Inquiry windows provide easy access to detailed and summarized
Multidimensional Analysis information. Not only can you perform inquiries by
analysis group or code, you also can click links to view analysis detail inquiry
windows from many of the distribution inquiry windows in Microsoft Dynamics
GP.

This information is divided into the following sections:

¢ Performing account analysis inquiries
*  Performing transaction analysis inquiries

Performing account analysis inquiries

Multidimensional Analysis lets you view the analysis breakdowns for individual
accounts. You can open account analysis detail inquiry windows from the following
windows:

¢ Invoice Distribution Inquiry window

e Journal Entry Inquiry window

e Payables Distribution Zoom window

e Purchasing Distribution Inquiry Zoom window
* Receivables Distributions Inquiry Zoom window
e Sales Distribution Inquiry Zoom window

e Transaction Entry Zoom window

When you select an account that has analysis information, an Account Analysis
button becomes available. To display an analysis detail inquiry window, select an
account for which analysis codes have been assigned, then choose the Account
Analysis button or choose View >> Analysis.

=] Payables Distribution Zoom El@l@l

Wendor ID 1021 Woucher Number 00000000000000386
Name Document Type Invoice:
Cunency ID UsSA Functional Amount $250.00

Account Analysis button Orignating Amount 425000

010 |* [Account [@]2[&[ Type Debit [Credit B
Deseriplion Oiiginaing Diebit | Diiginating Crecit | ¥

ACCOUFIt to Which ana/ySlS Distribution Reference

0000 [PURCH $250.00

codes have been assigned 1000-1000-0000 -2100-0000 [P&y $0.00 425000

Performing transaction analysis inquiries

Use the Analysis Inquiry window to view the transactions that have been recorded
against the codes in a selected group. You can view unposted transactions, as well
as posted transactions in open and historical years. In addition, you can view
detailed information about the originating documents by selecting a transaction
and clicking the Document Number link.
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PART 2 INQUIRIES, REPORTS, AND UTILITIES

To perform a transaction analysis inquiry:

1. Open the Analysis Inquiry window.
(Inquiry >> Financial >> Analysis)

i Analysis Inquiry. g@gl
‘/ 0K Redizplay

Einalysis Group 1D VERICLES

Group Description Wehicle Flest

Analysis Code 1D ABC1Z3

Code Description ServiceWan 1

Include: Unposted Open Histary iew: | by Account -

Account Document Number Amount Guantiy

Account Description Date Posting Date Paosting Description

000-1530-00 000000000000004E2 $6.00

000-1520-00 3348 $65.00

000-4510-02 MC25 $20.00

000-4510-02 SALES000000071002 $25.00

~
Code Tatals $115.00 0.00000
4 r @

2. Enter or select the analysis group and code to view transaction information for.
You can view unposted transactions, as well as posted transactions in open and
historical years. You can sort the transactions by account, by document number,

by document date, or by posting date.

3. To view detailed information about a transaction, select the transaction and
click the Document Number link.
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You can use Multidimensional Analysis reports to provide detailed or summary
information about analysis groups and codes. These reports can include both
posted and unposted transactions. You also can print setup lists showing your
analysis groups and codes, and the accounts they have been applied to.

This information is divided into the following sections:

e Multidimensional Analysis report summary
*  Specifying a Multidimensional Analysis report option

Multidimensional Analysis report summary

You can print several types of reports using Multidimensional Analysis. Some
reports, such as utility reports, automatically are printed when you run the
corresponding utility procedure. In order to print most setup or analysis reports,
you must set up report options to specify sorting options and ranges of information
to include on the report. For more information, refer to Specifying a Multidimensional

Analysis report option on page 26.

The following table lists the report types available in Multidimensional Analysis
and the reports that are in each type.

Report type Report Printing method

Setup reports Analysis Group Setup List Choose File >> Print in the
Analysis Group Maintenance
window or create report options
in the Multidimensional Analysis
Reports window.

Account Analysis Setup Report Create report options in the
Multidimensional Analysis
Reports window.

Analysis report Account Analysis Report Create report options in the
Multidimensional Analysis
Reports window.

Utility report Reconcile Group Balances Report | This report will be printed when
you complete the corresponding
procedure.
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Specifying a Multidimensional Analysis report option

Report options include specifications for sorting options and range restrictions for a
particular report. In order to print several Multidimensional Analysis reports, you
must first create a report option. Each report can have several different options so
that you can easily print the information you need. For example, you can create
report options for the Account Analysis Report that show either detailed or
summary information.
V. A single report option can’t be used by multiple reports. If you want identical options for
_@_ several reports, you must create them separately.

Use the Multidimensional Analysis Reports window to create report options for the
reports that have been included with Multidimensional Analysis.

To create a report option:

1. Open the Multidimensional Analysis Reports window.
(Reports >> Financial >> Multidimensional Analysis)

Il Multidimensional Analysis Reports

A& Cear | &b Fint |

Reports:
Account Analpsis Setup v

Options: Print List:

Account Analsis Setup-Detailed

Plermnses

2. Select a report from the Reports list.
3. Choose New to open the report options window.

4. Name the option and enter information to define the option. The name you
choose for the option won’t appear on the report.

The selections available for defining report options vary, depending on the
report type you've selected. Refer to the table for more information.

Report Available selections

Analysis Group Setup List Ranges: Analysis Group ID

Account Analysis Setup Detailed/Summary

Report Ranges: Segment ID

Account Analysis Report Detailed/Summary
Include: Unposted, Open, History
Ranges: Segment ID, Transaction Date, Posting Date,
Analysis Group ID, Analysis Code ID

5. Enter range restrictions. The Ranges list shows the available options for each
report.

vy
()~ You can enter only one restriction for each restriction type. For instance, you can insert

one Analysis Group ID restriction.
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Choose Insert to insert the range in the Restrictions list. To remove an existing
range from the list, select the range and choose Remove.

Choose Destination to select a printing destination. Reports can be printed to
the screen, to the printer, to a file or to any combination of these options. If you
select Ask Each Time, you can select printing options each time you print this
report option.

To print the report option from the report options window, choose Print before

saving it. If you don’t want to print the option now, choose Save and close the
window. The report window will be redisplayed.
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Chapter 5:

Utilities
Multidimensional Analysis includes a reconciliation utility that you can use to
verify the accuracy of records and to correct certain data errors.

The following information is discussed:

o What reconciling does
*  Reconciling analysis groups

What reconciling does

Reconciling is the process of verifying that your Multidimensional Analysis records
are accurate. You should use this utility only if the total amount recorded for an
analysis group doesn’t equal the sum of the amounts recorded for its individual
analysis codes.

The reconciliation process performs the following operations:
e It deletes the analysis group record for any transaction that has analysis groups
but no analysis codes, provided that the transaction has been posted through

General Ledger or is in history.

e It adjusts the group total if the group total doesn’t match the total of all the
group’s codes.

e It deletes analysis codes that aren’t assigned to an analysis group.

When processing is finished, the Reconcile Group Balances report is printed. The
report lists the analysis groups that were reconciled.

Reconciling analysis groups

Use the Reconcile Analysis Groups utility to ensure that the total amount recorded
for analysis groups equals the sum of the amounts recorded for individual analysis
codes.

To reconcile analysis groups:

1. Open the Reconcile Analysis Groups window.
(Microsoft Dynamics GP menu >> Tools >> Utilities >> Financial >> Reconcile
Analysis)

I Reconcile Analysis Groups E]‘El@
Options:
(%) ! Hecancie and Print Heport O Print Report
ve

2. Select whether to reconcile and print the Reconcile Group Balances report, or
print the reconcile report without reconciling information.

Print the report without reconciling if you want to find out whether

reconciliation is necessary, or if you want to know what operations the utility
would perform.
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3. Choose Process to reconcile analysis groups.

When the processing is complete, the Reconcile Group Balances report will be
printed.
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